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GENERAL 

1.1. PRECAUTION 
 

 Warning  Precautions when installing the scale. To ensure that you get the 

most from your scale, please follow these instruction. 
 

 

Do not disassemble the scale. 

When any damage or defect occurs, contact your 
CAS authorized dealer immediately for proper repair. 

 

Do not overload beyond the maximum weight limit. 

 

Scale must be grounded to minimize electricity static. 

This will minimize defect or electric shock. 

 

Do not pull the plug by its cord when unplugging. 

Damaged cord could cause electric shock or fire. 

 

To prevent from fire occurring, Do not place or use 
the scale near flammable or corrosive gas. 

 

To reduce electric shock or incorrect reading, 
Do not spill water on the scale or place it in 
humid condition. 

 

Avoid placing the scale near heater or in direct sunlight. 
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Insert plug firmly to wall outlet to prevent electric shock. 

 

 Attention  Make sure to plug your scale into the proper power outlet. 

For maximum performance, plug into a power outlet 30 minutes before the usage for warm up. 
 

 

For consistent and accurate reading, maintain 
periodical check by your CAS authorized dealer. 

 

Avoid sudden shock to the scale. 

 

Grab on the bottom of the scale when moving. 

 

Keep the scale away from other electromagnetic 
generating devices. 

This may interfere with accurate reading. 

 

Place the scale on firm and temperature consistent 
environment. 

 

By adjusting 4 comers of the scale, set the scale 
even using the built in scale leveling indicator. 
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1.2. INTRODUCTION 
 

Thank you for purchasing CAS CL8000 series. 
CL8000 is a PC-based price computing electronic scale. We have integrated intuitive and 
powerful functionalities in its design to address the needs of users in various 
applications, and we are confident that CL8000 will make operating your business easier. 
Remember, for proper installation and maintenance please have your CAS authorized 
dealer do the primary installation, programming, and demonstration. Your CAS 
authorized dealer also has a wide variety of supplies, accessories, and expansion 
options for whatever your new and increasing demands may require. Authorized CAS 
dealers are trained to help you with every aspect of the CL8000 series and should you 
need servicing, they are highly trained by CAS to assist you with virtually any problem. 

 

 

 

● Included Accessories 
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1.3. SPECIFICATIONS 
 

Max. Capacity 3/6 kg 6/15 kg 15/30 kg 

Interval 1/2 g 2/5 g 5/10 g 

Max. Tare -2.999 kg -5.998kg -9.995 kg 

A/D Conversion Rate Approx. 8 times / s 

Measurement Type Load cell 

Operating Temp. -10°C ~ 40°C (14°F ~ 104°F) 

Power AC 100~240V 50/60Hz 1.5A 

Printing Rate Max. 150 mm/sec 

Printing Resolution 202 dpi 

Label Size Width: 40 mm ~ 60 mm / Length: 30 mm ~ 200 mm 

Printer Type Direct thermal print 

 

 

● System 
 

CPU 
Intel® Celeron™ J1900 (2.0 GHz) Quad-Core Processor / Fanless 
(Standard) 

Chipset Intel® Bay Trail 

Storage PCA, PCB type : SATA 2 (3Gb/s) 2.5 inch SSD 64GB, Support AHCI 
B, U, SU type : mSATA SSD 64GB 

System Memory 4GB Standard (Type: DDR3L, Socket 1 x SODIMM) 

Graphics Integrated Intel HD Graphics  

Sound Realtek ALC662-VD 5.1 CH Audio 

 

 

● Display 
 

Size/Type 
PCA, PCB type : 15" TFT LED backlight, 9.7” TFT LED backlight 
B, U, SU type : 10.1" TFT LED Backlight, 7" TFT LED Backlight 

Resolution 
PCA, PCB type : 1,024 x 768 
B, U, SU type : 1,024 x 600 

Brightness 
PCA, PCB type : 300 cd/m² (typ.) 
B, U, SU type : 10.1” = 180 cd/m² (typ.), 7” = 350 cd/m² (typ.) 
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● Touchscreen 
 

Type Projective capacitive touch  

Interface USB 

 

 

● I/O Interface – PCA type 
 

Video Out 1 x VGA (with 12V power output) 

USB Port 6 (Rear 2, Back 4 / USB 2.0 x 6 Ports 

Serial Ports 

5 (COM1 with 5V/12V Power Output on 9 Pins, BIOS) 

  (COM2 ~ 3 RJ-45, full signal) 

  (COM4 RJ-11, Only TX/RX, 12V power output) 

  (COM5 Reserved) 

  (COM6 RJ-45, Only TX/RX, 5V Power Output) 

LAN 1 x gigabit ethernet, RJ-45 

Audio Out Line-out 

Power AC 100~240V 50/60Hz 1.5A  

OS  Windows 10 

 
 

 

 

 

 

● I/O Interface – B, U, SU type 
 

USB Ports 6 (USB 3.0 x 1 / USB 2.0 x 5) 

Parallel Ports 
2(COM1, COM4 full signal) 

1(COM 3 with 5V/12V power output on 9 pins, factory setting) 

LAN 1 x 100 Megabit ethernet, RJ-45 

Audio Out Line-in, Line-out 

Power AC 100~240V 50/60Hz 1.5A  

OS  Windows 10 
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● Instrument & Environment 
 

Color Dark gray 

Load Tray Size 368 x 288 (mm) 

Dimensions  

PCA, PCB type : 399(W) x 447 (D) x 631(H)(mm)  
B-Type : 399(W) x 450(D) x 171(H)(mm)  
U-Type : 399(W) x 485(D) x 578(H)(mm)  
SU-Type : 399(W) x 485(D) x 292(H)(mm) 
* Height: excluding rear LCD 

 

Note: Some of the specifications may change without prior notice. 
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1.4. DIMENSIONS 
 

● PCA type 
 

 

 

● B type 
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● U type 
 

 

 

 

● SU type 
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1.5. SETUP  
1.5.1. Basic Setup 

● PCA type 

 

 

● B type 
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● U type 
 

 

 

 

● SU type 
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1.5.2. Rear Display Assembly 

 

● PCA type 
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1.5.3. Installation of the Label Roll 

 

● Label Specifications 
 

Outer Diameter: 100mm 
Inner Diameter: 40mm 
Receipt Roll Width: 40, 50, 60mm 
Label Roll Width: 64mm (max.) 
 

 

 

● Printable Area 
 

Label Width: 56mm (max.) 
Label Length: 200m (max.)  
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● Please install the label roll in the following order: 
 

1) Pull the front handle to open the front door.  
  

 

 

 

2) Insert the roll into the label supplier pole, then mount the roll. 

 

 

* Turn the TPH lever to open, run the label through then hang the label’s end onto 
the rewinder bush. 



 

 

21 

3) Hang the label’s end onto the rewinder bush, then rotate the level to tighten the 
label.   
  

 

 

 

4) Return TPH setting lever to its original position then close the door.  
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5) Adjust the label (see below), then pull the TPH down.  
 

 

 

 

6) Press “Feed” Key. 

 

● If the label is out of position, please check the following: 
 

a, Set the label size 
b. Adjust the roll position 
c. Set the sensor 
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1.5.4. Power On/Off 

1) Booting 
 

1. Turn on the switch on the lower side of the scale. 
 

 
 

2. Press the monitor’s power button as in the picture below. 
   * Power button is on the bottom right corner of the monitor. 
 

● PCA type 
 

 

 

 



 

 

 

24 

 
3. Check to see if the windows have booted up normally. 
 

 

 

 

Once booted normally, the windows display “Tare/Weight/Unit Price/Price” on the 
upper side of the screen. 
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2) Shutting Down 
 

It is recommended that the windows is shut down from the O/S menu for system 
stability. 
Please close all applications before shutting down the windows. 
 
① Press monitor’s power button 
 

② Click “Power Off” to shut down. 
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2. SALES OPERATION 
 

2.1. STANDARD SALES OPERATION 
 

2.1.1. Sales operation - General type 
- Sales operation in the case of ‘General type’ keypad layout  
- Refer <3.6.4.1> Keypad Layout Type 
 

2.1.1.1. Selling Weighed Products 

 
1)  select the category (if you need to change the category) 
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2) Select PLU of the product (weighed product). 

If the product is on the next page, you can move the page. (swipe available) 
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3) Put the product on the scale. 
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4) when the weight value is stable, press ‘print’ to sell  

 

 

 

2.1.1.2. Selling Counted Products 

 

1) select the category (if you need to change the category) 
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2) Select PLU of the product (counted product). 

 

 

3) Key in number of units, then press “PRINT” to sell the product. 
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2.1.2. Sales operation - Full type 
- Sales operation in the case of ‘Full type’ keypad layout  
- Refer <3.6.4.1> Keypad Layout Type 
 

2.1.2.1. Selling Weighed Products 

1)  select the category (if you need to change the category) 
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2) Select PLU of the product (weighed product). 
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3) Put the product on the scale. 

 

 

4) when the weight value is stable, press ‘print’ to sell  
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2.1.2.2. Selling Counted Products 

1) select the category (if you need to change the category) 

 

 

2) Select PLU of the product (counted product). 
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3) Key in number of units, then press “PRINT” to sell the product. 
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2.1.3. Using Product Search Function 

1-1) You can select the product by clicking the search button. 
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1-2) You can either select the product from product list, or find it through the search 

button. You can search the entire list of categories if you use the search function in the 

Category screen. 
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2.1.4. Add Sales 

This function usually is used when the each product is packaged in a bundle. 

1) Select the item, press “add”. 
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2) As the label is printed, the item is added on the list 

- to keep selling item, click Exit button and go back to sale state. 

 

[ Printed label after the add sale ] 
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[ Sale screen after the add sale ] 

 

3) As the label is issued, the product is added to the list. 
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4) As the label is issued, the product is added to the list. 

The item is added on the list  

You can see the total information about the items which is on the list. 

To print the information, which is added to up to now, click the ‘sell total print’ button.  

when subtotal is printed, the list is initialized. 

 

[ Printed label after the add sale ] 
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[ Sale screen after the add sale]  

 

 

[ After the sell total ] 
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2.1.5. Change keypad settings on the sales mode 

2.1.5.1. Change a product keypad settings 

- You can set Product keypad settings directly on the sales screen 

This function operates only when Keypad Arrangement Method is ‘MANUAL’ in 

<3.6.4.4> Keypad Config. 

1) If you press a product keypad for 3 seconds, the keypad setting window pops up. 

If you change the setting, it is applied immediately to the sales screen. 

 

[Before] 
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[Change Product] 

 

 

[After] 
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2.1.5.2. Change a function keypad settings 

- You can set function keypad settings directly on the sales screen 

1) If you press a function keypad for 3 seconds, the keypad setting window pops up. 

If you change the setting, it is applied immediately to the sales screen. 

 

[Before] 

 
[Change Function] 
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[After] 

 

 

 

 



 

 

47 

2.2. SELF MODE 
2.2.1. Selling Weighed Products 
1) Choose the category from the home screen (category screen). You can select the 
product immediately if there is no category. 

 

 

2) Select PLU of the product (weighed product). 

If the product is on the next page, you can move the page. (swipe available) 
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3) Put the product on the scale. 

 

 

4-1) Once the measured value is displayed, the product is automatically sold and a label 

is printed out. 
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4-2) In case AUTO mode is disabled, press “PRINT” button 

 

 

2.2.2. Selling Counted Products 
1) Select the category from the home screen. (Category screen). You can select the 
product immediately if there is no category. 

 



 

 

51 

2) Select PLU of the product (counted product). 

 

 

3) Key in number of units, then press “PRINT” to sell the product. 

 



 

 

 

52 

 

 

2.2.3. Using Product Search Function 

1-1) You can select the product by clicking the search button. 
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1-2) You can either select the product from product list, or find it through the search 

button. 
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2-1) You can also use the search function in the selected category. 
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2-2) Using the search button in a category shows only products from the selected 

category 
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2.2.4. Additional Functions 

- Double click the logo in the upper left corner to display additional functions. 
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(1) TARE 

  - Press it to set the tare weight. 

(2) FEED 

  - Press it to draw out a ticket or a label. 

(3) CHESS 

  - Press it to print CHESS (for print quality test) 

(4) DATE TIME 

  - Press it to enter Setup – Date Time menu for setting the time zone. 

(5) ZERO 

  - Press it to set the zero point. 

(6) REBOOT 

  - Press it to restart the scale software. 

(7) SALES MODE  

  - Press it to enter SALES MODE screen  

(8) PROGRAM MODE 

- Press it to enter PROGRAM MODE. 
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3. PROGRAMING 
- Each menu in PROGRAM MODE is usable only with an account which meets its 

required  

 

How to access the menu.  

1) On sale screen, press gear shape icon at the top right to move to the program mode 

(The first screen of program mode is BOOKMARK menu) 
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Readable / Modifiable levels. 

- Logging in with a user account will enable reading and modifying of the menu which 

meets. 

 

Readable / Modifiable levels of the account.  

- Not logging in with any account will assign the user Guest levels.  

(Please refer to 3.4.2 Store – User & Security for user levels.) 
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3.1. BOOKMARK MENU 
- Bookmark menu can be used to store frequently accessed menu. 

1) Click in the following order: BOOKMARK. 
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2) How to add a bookmark: Click the “☆” on the submenu of your choice to add it to 

the bookmark list. 

- Active bookmarks are highlighted blue. 

- Click the “☆” again to remove the submenu from the bookmark list. 

 

 

3) Bookmarking a submenu will display the added submenu in the bookmark list, 

enabling a quick revisit. (Pressing “x” will remove the submenu from the bookmark list)  
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3.2. DATA MENU 
3.2.1. Data – PLU 

- This menu is for generating, modifying and deleting product data. 

 

 

3.2.1.1. Create New PLU 

1) Click “New” button. 
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2-1) PLU No. is automatically set to the next number. 

 

 

2-2) If PLU No. does not exist, you can create a new one. 

If the PLU No. exists, a pop-up window appears whether to load the existing 

information. 
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3) Click the filed to insert the information using on-screen keyboard. 

 

 

4) Click “Load Image” button to assign a product image. 

(Product images can be transferred via CL-Works Pro) 
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5) Type in necessary and additional data of PLU No., PLU Type, Unit Price and Name1, 

then save. 

 

 

3.2.1.2. Modify PLU 

1) Click a PLU to begin modification. 
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2) Modify PLU data, then press “Save” button. 

 

 

3.2.1.3. Delete PLU 

1) Click the PLU which needs to be deleted. 
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2) Click “Delete” button to delete the selected PLU. 
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3.2.1.4. PLU List 

1) Enter PLU menu to see a PLU list. 

 

 

 



 

 

71 

2) Search the Department 

 

 

3) Search the PLU by typing PLU No. or Name in the searching field. 
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4) PLU No., Short Code and Product Name fields can be clicked to arrange the items per 

the selected field. 
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3.2.2. Data – Department 

- This menu is for generating, modifying and deleting a query of department data  

 

 

1) Delete Department 

(Please note that Department No. 1 is undeletable) 

   *Caution: Deleting a department will also delete all PLUs in the department 

 



 

 

 

74 

3.2.3. Data – Group 

- This menu is for generating, modifying, deleting and querying Group data  

 

 

3.2.4. Data – Sales Message 

- This menu is for generating, modifying, and deleting Sales Message data  
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3.2.5. Data – Origin 

- This menu is for generating, modifying, and deleting Origin data  

 

 

3.2.6. Data – Barcode 

- This menu is for generating, modifying and deleting Barcode data  
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3.2.6.1. Create New Barcode 

1) Click “New” button. 

 

 

2) Type in Barcode No. and Name, then set Barcode Type. 
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3) Once the Barcode Type is set, choose a format from the list or manually key in the 

format. 

 

 

4) After completing the fields, click “Save” button. 
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3.2.7. Data – Tare 

- This menu is for generating, modifying and deleting Tare data. 

 

 

3.2.7.1. Create New Tare 

1) Click “New” button. 
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2) Type in Tare No. and Tare Name 

 

 

3) Choose a Tare Type 
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4) Depending on the Tare Type, the Tare value can be entered directly or through weight 

measurement. 

-Numeric Tare: you can directly enter the Tare value. 

 The Tare value must be entered according to the unit of weight measurement. 

( Ex: in the case of 6/15kg  e=d=2/5g,  less than 6kg : 0.02kg  / over 6kg : 0.05kg) 

If an incorrect value is entered, the following warning window is displayed 

 

 

-Weight Tare : Enter the actual weight measured value. 
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3.2.8. Data – Quantity Unit Symbol 

- This menu is for generating, modifying and deleting Quantity Unit Symbol data. 

(You can specify each PLU’s counting units for products) 
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3.2.9. Data – Ingredient 

- Two ways to Enter Ingredients 

1. indirect ingredient <3.2.9.1> 

 : Storing ingredient information in the ingredient menu and indirectly using the 

information by selecting it in PLU 

2. direct ingredient <3.2.9.2> 

 : Directly inputting ingredient information into PLU and using it. 

 

3.2.9.1. Indirect Ingredient 

1) Go to ingredient menu. 
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2) Enter ingredient information. 

 

 

3) Go to Data Maintenance > Select PLU Items Setting Menu 
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4) Set the ingredient ID field to “yes” and save. 

 

(If ‘Yes’ is set, Fields ingredient, ingredient 2 that are direct ingredient fields are automatically 

treated as No ) 

5) Go to Data > PLU 
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6) It can be used of the ingredient information you saved in the ingredient menu. 

 

 

3.2.9.2. Direct Ingredient  

1) Go to the Data Maintenance > Select PLU Items setting menu. 

 

 

 



 

 

 

86 

2) Set the ingredient and ingredient fields to “yes” and save. 

 

 

3) Go to Data > PLU menu. 
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4) It can be used this by directly entering the ingredient field for each product. 

 

 

 

3.3. DATA MAINTENANCE MENU 
- Please refer to the following steps to access Data Maintenance menu. 
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3.3.1. Data Maintenance – Select PLU Items 

- You can choose to display or hide PLU fields in Data - PLU menu. 

 

 

1) Items that are checked “Yes” will be displayed on the PLU; items with “No” will be 

hidden. Once the selection is complete, press “Save” button. 
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2) Enter “PLU” submenu under “Data” menu to make sure that the settings have been 

applied. 

 

 

3) Select the PLU. 
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4) Check the PLU fields. 

 

 

 

 

3.3.2. Data Maintenance – Import PLU data 

- Import PLU data from external device 

3.3.2.1. FTP 
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1) Enter the FTP server connection information (FTP Config) 

 

 

 

# IP Address 

# Port 

# User ID – FTP server user ID 

# Password – FTP server password 

# FTP File Path – FTP Server file Path 

# FTP File Name – FTP Server file name, extension 

# FTP Backup File Location – FTP server backup path  

# FTP Backup Delete – Whether to back up and delete files in FTP Server 

# File Comment – Skip Sign. (Lines beginning with this letter are ignored) 

# File Separator – Separates each item in the file 

# File Start Line – The line number in the file to start reading (If it starts with 0 or 1, read 

from the first line) 

 

2) Click ‘Connect Test’ button to check the possibility of connection 
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3) Move to the ‘PLU Field Matching’ menu 

 

 

4) Click ‘Download File’ button to download file from FTP server. 

 Check the first line (start line) data after success to download 
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5-1) Assign each item in the file to each item in the PLU 

Click ‘Add’ button to add additional information 
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5-2) Select ‘None’ for unused items 

Each item can set once. (‘None’ can set multiple times) 
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5-3) ‘=’ button can change the location 

 

 

 

5-4) Click the ‘Edit end’ button to delete the fields using delete icon.  

Click the ‘Save’ button to save the information. 
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6-1) Use ‘Replace’ function to convert the value of items  

 Click the ‘Replace’ button. 

 

 

6-2) Click the ‘New’ button. 
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6-3) Enter the value, click the ‘Save’ button 

 

 

 

# PLU Field – Select PLU item 

# Original Text – The Original value of the item in file 

# Replace Text – The Value to change 

# Ex) In case of PLU Type, Original Text :2, Replace Text :1 

=> If the value of PLU type in the file is 2, it is changed to 1  

 

6-4) Delete or modify the Replace settings 
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7) Click the Import File button to import the file data into the scale according to the 

matching settings. 
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8) Set the automatic import schedule in the ‘FTP Scheduler Config’ menu. 
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# Use Scheduler– Whether to automatically proceed with the import operation 

# Start Date / End Date  

# Start Time / End Time  

# Day / Hour / Minute – Schedule Interval 

# If ‘Use Scheduler’ is set to YES, the operation of downloading the file from the FTP 

server and saving the PLU data to the scale is repeated at every set time interval within 

the set time and date. 
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3.3.3. Data Maintenance – Delete data 

- This page is for deleting saved data by category. 

 

 

 1)  This menu can only be accessed by users with user authority level 3 (admin) or 

higher.  Click the login button to log in. 
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2) Click “Delete All” button located in the same row as the item which needs to be 

deleted entirely. 

 

 

3) Once the confirmation window pops up, click “OK” to delete all data of the item. 

  User will be alerted if there is a PLU which uses the selected data. 

Deleting data in use will remove the data from the used PLUs as well. 
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4) Check the deleted data. 

 

#You can also see in the field(s) which also used the deleted data that the data are 

deleted. 

 

 

#Caution: In case at least one data needs to remain in a given item, performing Delete 

All will not delete Data No. 1 (e.g.: Department). 
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3.3.4. Data Maintenance – Label Form 

- In this menu, you can delete the label form. 

 

 

 1) This menu can only be accessed by users with user authority level 3 (admin) or 

higher.  Click the login button to log in. 
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2) ‘Default Form’ is a label form already saved in the scale and cannot be deleted. 

 

 

3) ‘User Design Form’ is a label form saved by the user in the scale, and can be deleted 

by clicking the ‘Delete’ button after checking the check box. 
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3.3.5. Data Maintenance – Select Nutrifact Items 

- In this menu, you can set the items to be used among Nutrifact items. 
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1) After setting the Nutrifact items to be used as Yes, you can save them by clicking the 

Save button. 

 

 

2) When set to No, it is not displayed in the Nutrifact item of PLU. 
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3.3.6. Data Maintenance – Delete File 

- In this menu, you can delete image files related to PLU, Advertisement and Category.  

1) After selecting One of the PLU, Advertisement or Category, check the file to be 

deleted and click the Delete button to delete it. 
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3.4. STORE MENU 

 

 

3.4.1. Store – Store Info 

- This menu is for generating, deleting, and modifying store info. 

 

 

 

3.4.1.1. Register New Store Info 
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1) Click “New” button. 

 

 

2) Key in Store Info ID, Name, Telephone and Text, then press “Save” button. 

 

 

 

 

3.4.1.2. Modify Store Info 
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1) Click a Store Info to begin modification. 

 

 

2) Modify Store Info, then press “Save” button. 

 

 

 

 

3.4.1.3. Delete Store Info 

1) Select the Store Info which needs to be deleted. 
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2) Click “Delete” button to bring a pop-up window to confirm deletion. 

 

 

 

 

3) Click “OK” button to delete the selected Store Info. 
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3.4.2. Store – User & Security 

3.4.2.1. User 

- This menu is for generating, deleting, and modifying User info. 

 

 

1) This menu can only be accessed by users with user authority level 3 (admin) or higher.  
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Click the login button to log in. 

 

 

3.4.2.1.1. User Level 

1) There are three user levels.  

Each user level is given its own Readable / Modifiable levels 

Readable / Modifiable levels attributed to each user level can be configured in 3.4.2.2 

Menu Permission. 

User type Level 

Guest 0 

User 1 

Chief user 2 

Admin 3 

User will be given permission levels that fits the account when logging into PROGRAM 

MODE. 

Not logging in with any account will auto-assign the user with Guest permission levels. 
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3.4.2.1.2. Create New User 

1) Click “New” button. 

- A new user account can be created only with the admin account. 

 

 

2) Type in User ID, Nickname, Password, Level, then press “Save” button. 
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3.4.2.1.3. Modify User 

1) Choose a user which needs to be modified. 

- User can be modified only with the admin account. 

 

 

2) Modify user info, then press “Save” button. 
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3.4.2.1.4. Delete User 

1) Choose a user which needs to be deleted. 

- User can be deleted only with the admin account. 

 

 

2) Click “Delete” button to bring a pop-up window to confirm deletion. 
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3) Click “OK” button to delete the selected user. 

 

 

3.4.2.1.5. Simple Login 

1) User can quickly log in by entering only the password using <User index Number + 

Password>.  
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3.4.2.2. Menu Permission 

- This menu is for setting permission level for reading or modifying each menu of the 

scale. 

# This menu is readable only with the admin account. 

 

 

1) Set permission level with each submenu, then press “Save”. 
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Modifiable (write permission) – Permission for the current user to modify the selected menu 

Readable (read permission) – Permission for the current user to access the selected menu 

 

 

2) Readable level cannot be set higher than Modifiable level.  

(Modifiable level >= Readable level). 
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3) Configuring Readable / Modifiable levels of each menu will prohibit users which do 

not meet the Readable / Modifiable levels from reading or modifying the given menu. 

For example, if the account that a user used to log in has User levels: 

If Readable level of “Group” menu is set to “User”, Group menu will be visible to the 

user. 

However, If Readable level of “Group” menu is set to “Admin”, Group menu will not be 

visible to the user. 

 

 

If Modifiable level of “Group” menu is set to “User”, user will be able to modify the 

“Group” menu. 

However, if Modifiable level of “Group” menu is set to “Admin”, user will be not able 

to modify the  

“Group” menu. 
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3.4.2.3. Function Permission 

- In this menu, you can set up the permission to use Function key. 

# This menu is readable only with the admin account. 
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1) Set permission level with each Function Key 

(ex, Override – use more than Admin authorization) 

 

 

2) On sale screen, Press the function key with permission (Ex: Override) 
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- When you click the function key with permission, the login window appears 

As the permission level is Admin, In order to use function key you have to login at least Admin (3 

level) authority. 

 

3.4.2.4. Security Config 

- This menu sets security-related details. 

# This menu is readable only with the admin account. 
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1) set the each item 

 

# Function Key User Check-> when using the function key, whether to check the 

authority  

 

3.4.3. Store – Advertisement 

3.4.3.1. Slide Show 

- This submenu is for configuring auto-play of slide show when scale is not being used.  
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1) Click “New” button. 

 

 

2) Set up a slide show for videos or images. 

# Use Advertisement - You can choose whether to use it or not. 

 (Only one slideshow can be set to Yes., If you select Yes and save, other slideshows will 

change to No.) 
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# File – You can add images or video files to be used in the slide show. 

( + : add,   - : delete ) 
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# Hour, Minute, Second - When an image is added, set how long the image will be 

displayed.  (Video is not affected.) 

 

# Date Setting - You can set the date and time the slide show will run. 

 (If ‘Use Advertisement’ is set to No, it always works.) 

# Day of Week – Specify the day of the week  

(If Date Setting is Yes, one must be checked) 

# Start Date / End Date  

# Start Time / End Time 
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# Date / time 

 

 

 

 

3) Moving to the home screen and not using the scale for a set amount of time will 

begin the auto-play. 
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4) Touching the screen or changing the loaded weight will stop the commercials and 

resume the sales mode. 

 

 

3.4.3.2. Advertising Setting 
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1) Wait Time(Sec) : Ads are shown at times when the scale is not in use.  

If the scale has not been used for the time set in Wait Time, an advertisement is 

displayed. 

2) Movie Type : It can be set whether to display the slideshow video or image on the 

customer screen or the clerk screen when using dual monitors. 
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3.4.4. Store – Category 

- This menu is for generating, modifying and deleting Category info. 

1) Click in the following order: Store -> Category. 

 

 

3.4.4.1. Create New Category 

1) Click “New” button. 
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2) Type in Department, Category No., Name, Image and Active, then press “Save” 

button. 

 

 

 

3) Click “Load Image” button to assign a category image. 
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3.4.4.2. Modify Category 

1) Click a category to begin modification. 

 

 

2) Modify info in the category fields, then press “Save” button. 
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3.4.4.3. Delete Category 

1) Select the Category which needs to be deleted. 

 

 

2) Click “Delete” button to bring a pop-up window to confirm deletion. 
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3) Click “OK” to delete the selected category. 

 

# Category 1 cannot be deleted. 
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3.5. REPORT 

 

 

3.5.1. Report – Standard 

3.5.1.1. Period 

- This menu is for viewing the sales report by period 
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1) Check the sales information by year, month, day, week, day of the week, and hour. 

 

[Year-Report] 

 

 

[Month-Report] 
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[Day-Report] 

 

 

[Weeklly-Report] 
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[Week-Report] 

 

 

[Hour-Report] 
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2) Select a date to see sales information for the date. 
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3) Check the sales records by department. 

 

 

 

 

4) Use the product name or product number to check the sales record. 
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5) If click the graph icon, you can check the corresponding information as a graph. 
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3.5.1.2. Report Type 

- This menu is for viewing the sales report by PLU or department 

 

 

 

1) View sales records for day, a week , a month by PLU or category. 

- Check the sales record by selecting the product name or division. 
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2) Search by product (department) name or product (department) number. 

 

 

 

 

3) When you select a product, you can view detailed information. 
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3.5.2. Report – Management 

3.5.2.1. Delete Transactions 

- This menu is for deleting report data 
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1) Delete sales records by period or all. 

 

 

 

3.5.2.2. Other Report Settings 

- View the sales report by PLU or department 

 

 



 

 

149 

 

 

# Delete Scheduler (Day)  
: When the scale is turned on, data that have passed the period set in this item are 

automatically deleted.  
For example, if you enter 365, sales data older than 365 days will be deleted. 
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3.6. SETUP MENU 
3.6.1. Setup – Global setting 

3.6.1.1. Label ID 

- This menu is for configuring Global Setting – Label  

 

 

1) You can choose to use or unuse Global Label, and the label form which you would use. 

 

# First Label – The first label form which is used at the event of sales. 
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3.6.1.2. Barcode 

- This menu is for configuring Global Setting – Barcode  

 

 

1) Check “YES” in the “Use Global Barcode” row, select each barcode item then press 

“Save” button. 
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# Weight PLU Barcode → Weighed product 

# Count PLU Barcode → Counted product 

# PCS PLU Barcode → PCS product 

# MISC Weight Barcode – MISC  Weighed product 

# MISC Count Barcode – MISC Counted product 

# MISC Pcs Barcode – MISC PCS PCS product 

# Add up TTL Barcode – Barcode 1 of  Total Label 

# Add up TTL Barcode2 – Barcode 2 of  Total Label 

# Barcode2 → For Barcode2 

 

 

3.6.1.3. Scale Config 

- This menu is for configuring Sales Mode and templates of scale. 
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1) set each item 

 

# Scale ID -scale number 

# PCS Symbol – The unit that follows the number of Count/PCS items sold (Global 

Setting) 

# Department No. – The department number used to call the product call. 

# Prefix – The fixed value printed on the barcode. 

# Store No. – Store information, 

# Use Transaction – Whether to use real-time report transmission. 
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3.6.2. Setup – Print 

3.6.2.1. Print Label Items 

- This menu is for setting print options by field when printing labels. 

 

 

1) Once the setting is complete, press “Save” button. 
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3.6.2.2. Label Caption 

- This menu is for configuring printing value when printing caption portion of label fields. 

 

 

1) Type in values in the label caption fields of your choosing, then press “Save” button. 

(Printing label caption fields will print the saved values) 
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3.6.2.3. Mark Down 

- This menu is for setting whether to apply Mark Down when printing the Mark Down 

field among label fields. 

 

 

1) Markdown can be set. 

 

 



 

 

157 

3.6.2.4. Add-up Total 

- This menu allows to set whether or not to issue a label for Add sales. 

 

 

1) It can be set whether or not to print labels for Add sales.  

(If No is selected for Item Label, only sales information is recorded when selling a 

product, and no label is issued.) 

 (If No is selected for Total Label, only sales information is recorded when Total Label is 

issued after Add sales, and no label is issued.) 
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3.6.3. Setup – Sale 

- This menu is for configuring sales-related settings. 

 

 

1) Click “Save” button to save the sales configuration. 

 

# Save With Changed Price 

 : When issue after changing the unit price of a product, the unit price of the issued product is 
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saved. 

# Save Fixed Price Change 

 : When change a product to a fixed price product using the fixed price function key and then 

issue it, the issued product is saved as a fixed price product. 

# Start Auto mode 

: Set On / Off status of Auto mode when the application starts. 

If Auto mode is on, a product will be auto-sold and label printed out once the 

indication stabilizes. 

# Product Call Type 

: Set values which will be used when looking up products. 

PLU NO – Look up product that corresponds to the PLU No. 

Short Key – Look up product that corresponds to the Short Key. 

# Use Prefix Format 

: Set whether to enter the Prefix value in DD filed among barcode formats. 
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3.6.4. Setup – Keypad 

3.6.4.1. Keypad Layout Type 

- Keypad layout type are two types’ General type, full type 

1) General Type 

On sale screen. Both product key and function key are displayed.  

On general type, you can use 2 function key pages.  

 

[Page 1] 

 

[Page 2] 
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2) Full Type : There is only products key on the sale screen, if you click the side tap, the 

function key  appears 

If you call the product in the sale screen, the function key appear automatically.           
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3.6.4.2. Keypad Arrangement 

- This menu is for design the Keypad. 

When ‘Keypad Arrangement Type’ in the ‘Keypad Config’ menu is set to MANUAL, the 

status set in this menu is applied to the sales screen.(see #Keypad Config ) 

 

 

3.6.4.2.1. Change category 

1) You can select category and set the keypad for that category. 
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3.6.4.2.2. Add page 

1) You can add a keypad page by clicking the New page button. 

 

 

 

 

3.6.4.2.3. Delete page 

1) You can delete the page on the keypad by clicking the page Delete button.  

(Page 1 cannot be deleted.) 
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3.6.4.2.4. Change page 

1) You can change it by selecting the page of the category. 

 

 

3.6.4.2.5. Edit keypad 
- Product or function keys can be assigned to each item on the keypad. 

1) Set the keypad to Edit Mode. 
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2) You can click an empty item on the keypad to specify a product, or click an existing 

keypad item to modify it. 

 

 

 

3) Set product, image, font, etc. on the keypad. 

 

# Select a product. 

# Nickname can be set to display on the keypad instead of the product name. 

# You can set the font size and color.  

# You can set the image of the product. 
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4) The registered keypad is displayed on the screen. 

 

 

3.6.4.2.6. Delete keypad item 

■ You can delete each item on the keypad. 

1) Set the keypad to Delete mode. 
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2) You can click on the keypad entry to delete it. 

 

 

 

3) You can check the deleted keypad items. 
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3.6.4.2.7. Add keypad item 
- Each item on the keypad can be added. 
 

1) You can add keypad items by clicking the New Product button. 

 

 

2) You can check the added keypad items. 
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3.6.4.2.8. Save keypad 

- You can save the set keypad information.  

1) You can save the changed keypad information by clicking the Save button. 

 

 

The edited keypad is displayed on the sales screen. 
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3.6.4.3. Function Keypad 

- This menu is for configuring the Function Keypad. 

 

 

1) Set the function key type  
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2) Set the page  

  General Type: page option: 1-2 pages. / Full Type: page option :1 page 

 

 

 

3) Press “new fnkey” to add the function key. Or you can modify existent key. 

Designate each function key’s Nick Name, Font Size, Font Color, Background Color etc. 

 

- When setting the color, you can set it by selecting a color or directly entering the 

RGB color code 
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- You can set Font size(8~40) 

 

 

 

 

 



 

 

173 

4) You can delete each key by changing Edit mode to Delete mode. 

 

 

5) Press ‘save’ to save the setting. 
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3.6.4.4. Keypad Config 

- This menu is for configuring the Keypad. 

 

 

1) set each item  

 

# Keypad layout type – Keypad display type. 



 

 

175 

# Keypad Image Use – Whether to use the image of the product keypad. 

# PLU keypad size – Set product tile size that is displayed on Self Keypad screen. 

# Keypad Arrangement Method  

: Can choose to auto-arrange products or manually assign their locations. 

- AUTO: Auto-assigns PLUs (product info) to the keypad in sequence. 

- MANUAL -> User manually assigns products to the keypad. 

 

# Self Keypad Type: Set product tile size that is displayed on Self Keypad screen. 

# Keypad Arrangement Type 

: Can choose to auto-arrange products or manually assign their locations. 

- AUTO: Auto-assigns PLUs (product info) to the keypad in sequence. 

- MANUAL -> User manually assigns products to the keypad. 

 

 

3.6.4.5. Product Info 

- this menu is for configuration each product information on sale screen 
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1) After selecting the category and number of product information to use, you can set 

product information by drag and drop in product info. 
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3.6.5. Setup – Date Time 

3.6.5.1. Setup – Date Time 

- This menu is for configuring the standard time zone. 

 

 

1) Set the Mode to AUTO, then select the country to set the time. 

(Time will auto-adjust only if an internet connection is available) 
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2) It is also possible to enter date and time manually by selecting MANUAL Mode. 

 

 

3.6.5.2. Setup – Date Time Format 

- You can set the format of the date/time displayed on the screen and the date/time 
printed on the label. 
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1) After setting each value, you can save it by clicking the Save button. 

 

# Date Format -> The order of year, month, and day when displaying dates 

# Time Format -> Hour, minute, second display format 

# Year Format -> Year display format 

# Month Format -> Short form of month 

# Date Separator -> Date Separator ex)  ‘-‘  =>  2020-01-01 

# Time Separator -> Time Separator ex)  ‘:’  => 12:34 
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3.7. DEVICE MENU 
 

3.7.1. Device – Printer 

 

 

 

3.7.1.1. Label Size 

- This menu is for configuring label / ticket size. 

Width / Height / Gap Length (Length of the gap between the labels) 

-> Clicking “Test” button will auto-adjust the size. 
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3.7.1.2. Sensor Calibration 

- This menu is for configuring Gap sensor and Peel sensor values. 

Click “Start” button to auto-adjust Gap sensor and Peel sensor values. 

 

 

3.7.1.3. Sensor & Motor 

- This menu is for turning on / off the sensors and motor. 
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# Peel-Off Sensor: Use / Disuse Peel-Off Sensor  

(Sensor for checking whether the printed label has been collected by a user). 

# Rewind Motor: Use / Disuse Rewind Motor  

(Rewind Motor does not operate in ticket mode, and the label operates gapless). 

# Out of Paper Threshold: Set refill paper threshold. 

# Label Paper Type: Set “No Gap” for gapless label, and set “Gap” for label with gap. 

# Head-Up Sensor: Can choose to use / disuse Head-Up Sensor  

(a sensor for checking open / close status of the printer head). 

 

 

3.7.1.4. Print Intensity 

- This menu is for adjusting printing darkness. 

You can check the darkness of the printed material by printing CHESS through “Test” 

button 
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3.7.1.5. Adjust Feed Length 

- This menu is for adjusting label paper. 

Enter feed value in between -200 - +200 (Use “Test” button to verify) 

 

 

3.7.1.6. Label Preprint 

- This is the preprint menu (setting preprint area) 

# Preprint: Choose whether to use preprint feature.  

# Preprint Length: Enter a value between 0 – 10 mm 
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3.7.1.7. Reverse Feed 

- Configure to allow / prevent Reverse Feed when printing. 

 

 

3.7.2. Device – Network 

3.7.2.1. Network Setting 

- This menu is for configuring network of the scale. 
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1) LAN card also is configurable. 

 

 

2) If DHCP is selected, IP, Subnet Mask, Gateway and DNS will be auto-configured.  

Press “Save” button. 
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3) If “Static” is selected, you can manually input IP, Subnet Mask, Gateway and DNS.  

Press “Save” button. 

 

 

 

4) If a wireless network card is detected, wireless network card option will appear on 

the screen. 
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5) If a wireless network card is detected, list of available wireless networks will be 

displayed. 

Select a wireless network to access it. If the selected network is password-protected, 

you must enter the password to access the network. 
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3.7.3. Device – Scale Info 

3.7.3.1. Version 

- This menu is for checking scale version and checksum value. 

 

 

1) You can check the scale version and the checksum value. 

 

# Main Version: Version info of the main software. 
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# Additional Information: County and mart info. 

# Weighing Module Version: Version info of weighing module (checksum exists). 

# Printer Module Version: Version info of print module (checksum exists). 

# Launcher Version: Version info of software launcher. 

# UI Version: Version info of UI (screen) (checksum exists). 

# Service Version: Version info of Service (functions) (checksum exists). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

190 

3.7.3.2. License 

- This menu is to display license 

 

 

1) You can check license information. 
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3.7.3.3. Scale Frequency Of Use 

- This is a menu to check the usage information of the scale. 

 

 

1) This menu can only be accessed by users with user authority level 3 (admin) or 

higher. Log in by clicking the Login button. 
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2) Information of the scale usage can be checked. 

 

# TPH total print length: TPH total print length (cannot be initialized)  

# Print length after TPH replacement: Print length after TPH replacement (can be initialized)  

# TPH replacement date: TPH replacement date  

# Total number of overweight: total number of overweight  

# Number of overweight after calibration: Number of overweight after calibration  

# Total weighing frequency: The total number of weighing scales, except when it is stable and 0 

(cannot be initialized)  

# Weight Calibration Date: Weight Calibration Date  

# Total scale operation time: Total scale operation time (based on production date, cannot be 

initialized)  

# Operation time after scale inspection: Scale operation time (based on inspection date)  

# Scale inspection date: Scale inspection date 
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3.7.4. Device – Test 

- This menu is for conducting equipment test. 

 

 

3.7.4.1. Test Main Screen 

1) Select Language and Type, type in IP, Gap Reference Value and Peel Reference Value,  

then press “Start” button to run the comprehensive test (In the order of Display Test – 

IO Test). 

Click the items on the right to conduct individual tests. 
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2) Check the results -> Click “Print” button at IO Test (the last test) to print the results. 

 

 

- Clicking “Print Result” button in the main screen will also print the results. 
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- Failed tests are highlighted red, passed green, and pending blue. 
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3.7.4.2. Display Test 

 - This menu is for testing the display. 

 - Touch the screen to move onto the next screen, where you can proceed with the test. 

 

 

 

- Upon completion, press “Pass”. Then click “Next” button to move onto the next test. 
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3.7.4.3. Touch Test 

- This menu is for testing screen touch function. 

- Upon completion, click “Next” button to move onto the next test. 
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3.7.4.4. AD Test 

- This menu is for testing the weighing module. 

- Put a weight equal to or greater than 1 kg. If the measurement remains stable for 3 

seconds, Pass is displayed. 

- Once the test is complete, click “Next” button to move onto the next test menu. 
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3.7.4.5. Printer Sensor Test 

- This menu is for testing the sensors. 

 

 

(1) GAP / PEEL Sensor Test 

 - Click “Cal” button to check Gap Sensor and Peel Sensor values. If no issues are found, 

Pass will be displayed. 

(2) PEEL-OFF Test 

 - Click “PEEL-OFF Try” button, then check the PEEL-OFF Sensor. 

 - Check the PEEL-OFF Sensor as you change its value.  

(Bind / unbind the sensor to change the value) 

 - If the value changes four times within the duration of the test, Pass will be displayed. 

(3) HEAD-UP Test 

 - Click “Head Up Try” button to start the test. 

 - Move the Head Up Sensor up and down to check for any issues. 

 - If the values change four times within the duration of the test, Pass will be displayed. 
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3.7.4.6. Print Test 

1) Click “Print Test” button to start the print test. 

 

 

 

2) If the test material is printed, click “Pass”; if not, click “Fail”. 
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3) Click “Next” to move onto the next test. 

 

 

 

3.7.4.7. Cash Drawer Test 

1) Click “Cash Drawer Open” button to test whether the cash drawer opens. 
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2) If the cash drawer opens, click “Pass”; if not, click “Fail”. 

 

 

3) Once the open test is complete, proceed to the next test. 
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3.7.4.8. IO Test 

1) You can conduct USB ports and Ethernet communications test.  

 

 

2) Connect to all USB ports, then start the test by pressing “USB Try” button. 
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3) Click “Ethernet” button to test Ethernet communications. 

 

 

 

4) Once the tests are complete, press “Print” button to print the results. 
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3.7.5. Device – Remote Support 

- This menu is for allowing remote access.  

(Execute TeamViewer to allow remote access 

 

 

1) Click “Start TeamViewer” button to execute TeamViewer.      
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2) Once TeamViewer starts running, enter ID and the password to remotely control the 

scale.  (Exiting the screen will not quit the TeamViewer)  

 

 

3) When the remote control session is finished, go back to the TeamViewer screen and 

click “Close TeamViewer” to end the remote control (=quit TeamViewer application)    
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3.8. ADMIN MENU 
- Go to Admin menu. 

This menu is accessible only when logging in with User level 4 (dealer) or higher. 

 

 

 

3.8.1. Admin – Parameter 

3.8.1.1. Sale 

- This is a setting menu related to sales. 

 

 

1) Set each item. 
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# Same-Weight product sales limits range 

- This is the threshold for determining automatic issuance when using Prepack mode. 

Automatic issuance is performed when the weight changes beyond the set value.  

Only values from (10 to 99) can be saved. 

# Allow the weight of the count/pcs product 

- At the sales by count PLU, it can be set sales by product even if there is weight on the scale.  

(If set as ‘Yes’: sales by product is allowed.) 

(If set as ‘No’: sales by product is not allowed.) 

# X Key Allowed for Weight Product 

 - It is a setting as to whether to enable X (multiplication) issuance of weight Product. 

# Override Only Unit Price Zero PLU 

 - When set 'Yes', you can automatically enter the price when you call a product with a unit price 

of 0. (Called in Override state for a product with a unit price of 0) 

# Save Override Only Use Price Zero PLU 

- ‘When set to ‘Yes’, if ‘Override Only Unit Price Zero PLU’ is ‘Yes’, the unit price is saved when 
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selling after calling the product with a unit price of 0. 

# Allow Changing Unit Price (Weight Product) 

 - When set to ‘Yes’  and a weight product is called, the price is automatically entered. (Called in 

Override status when calling weight products) 

# Use Temp Key [TYPE] 

- This is the setting for saving after changing the product type when using the [TYPE] 

function key.  

(Yes: Use [TYPE] function temporarily (do not save) / No: Save the changed type state 

(save)) 

# Ride Second Position  

- This is a function that is used when the FOR key does not exist, and it is a function 

that can change the price using the override key for count product 

3.8.1.2. Barcode 

- This menu for configuration Barcode. 

 

1) Set each item. 
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# Remove barcode last digit(price) 

- The cutting position of the price of the barcode  

(For the part below the decimal point) (Ex. 3.456 -> 3.4) 

# Remove barcode last digit(weight) 

- The cutting position of the weight of the barcode 날짜 

(For the part below the decimal point) (Ex. 3.456 -> 3.4) 

# Remove barcode last digit(item code) 

-  The cutting position of the item code of the barcode  (Ex. 12345 -> 1234) 

#  Barcode Date Format 

- This is setting for the date format on the barcode  

# Weight Barcode Print Setting 

- This is a setting to convert the barcode format when printing weight barcode format (W).  

0 : Print the weight on the weight barcode  

1: If the PLU type is COUNT, the count is printed on the weight barcode format(W).  

2: “1” is printed on the weight barcode format(W).for Fixed price sales      
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3 : Use both 1 and 2 

# Common Barcode Settings 

-  This is the setting whether to set each barcode field in batches. 

3.8.1.3. Print 

- This menu for configuration Printing. 
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1) Set each item. 

 

- Label Price Format : when the sub symbol doesn’t exist  

 

- Label Price Format : when the sub symbol exists 
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# Print Net Weight Symbol 

- This is the setting of whether to print the unit of weight together when printing the weight field. 

# Print Preset Tare Symbol 

- This is the setting of whether to print the unit of weight together when printing the tare weight 

field. 

# Label Price Format 

- You can set the Subsidiary currency unit. 

(After entering, click the Apply button and it will be reflected in the Label Price Format.) 

# Label Price Format 

- This setting is for the label price format. 

(if there is sub symbol, it display more format include Sub symbol.) 
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3.8.1.4. Round 

- This is the round/down setting menu for Total Price. 

 

 

1) Set each item. 

 

#  Price Round 

- round/down 

#  Decimal places 



 

 

215 

- Rounding position (Includes the number of digits after the decimal point.) 

 

#  Price Round Apply 

- Rounding method. (No Use –No use/ For each PLU – Apply to each product.) 
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3.8.1.5. Tare 

-This menu is for configuration Tare  

 

 

3.8.1.6. Weighing 

-This menu is for configuration weighing.  
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1) Set each item. 

 

■ Remove label last digit(weight) 

 - The cutting position of the weight Item of the Label  

(for the part below the decimal point) (Ex. 3.456 -> 3.4) 

■ Print under M.W (Auto Mode) 

 - This is the setting to set whether to print less than the minimum weight in Auto 

mode. 

■ Print under M.W 

 - This is the setting to set whether to print less than the minimum weight. 

 

3.8.1.7. Weight Unit 
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3.8.1.8. Communication 

- This menu is for configuration communication.  

 

 

3.8.1.9. Currency 

- This menu is for configuration Currency.  
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1) Set each item. 

 

■ Currency Symbol Setting  

- After changing the currency symbol, if you turn off and then turn on the power of the 

scale, the currency symbol of the scale will change. 
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3.8.1.10. Discount 

- This menu is for configuration Discount. 

 

 

1) Set each item. 

 

■ Use Unit Price for key discount 

 - If ‘Yes’ is set, the unit price will be discounted when the discount function (-

discount, %discount) is used.  
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- If ‘No’ is set, it will be discounted from the total price. 

 

3.8.1.11. Display 

- This menu is for configuration Display. 

 

 

1) Set each item. 
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■ Display price digits 

- You can select the digit displayed on sale screen (7-9 digit, include decimal point) 

■ Menu Font Size Setting 

- It can be set the font size used in the program mode. 

■ Sale Font Size Setting 

- It can be set the font size used in the sales mode 

■ Interval to Restore the Touch Panel(sec.) 

- Restore the focus of the touch panel to the main screen at each set time. 
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3.8.1.12. Keypad 

- This menu is for configuration keypad. 

 

 

3.8.1.13. Management 

- This menu is for configuration Management 
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1) Set each item. 

 

■ Logo Login 

- You can set whether to log in or not when you move to the program mode using 

loge/setting button on sale screen. 

 

3.8.1.14. Menu 

- This menu is for configuration Menu 
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1) Set each item. 

 

■ Department use (Yes/No) 

- ‘When setting ‘Yes’, Department No. is used, and all previously used Category No. 

and related data (PLU, Keypad, Report, Product Info, etc.) are deleted except item 

No. 1. 

- When ‘No’ is set, Category No. is used, and all previously used Department No. and 

related data (PLU, Keypad, Report, Product Info, etc.) are deleted except item No. 1. 
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3.8.1.15. Report 

- This menu is for configuration report 

 

 

3.8.1.16. Sign 

- This menu is for configuration sign 
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1) Set each item. 

 

■ 1000 Unit Price Separator 

- It is a price 1000 unit separator. 

■ 1000 Unit Weight Separator 

- It is a weight 1000 unit separator. 

■ Decimal Point Separator 

- It's a decimal separator. 
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3.8.1.17. Nutrifact 

- This menu is for configuration Nutrifact 

 

 

1) Set each item. 

 

■ Nutrifact Number of decimal places 

- This is the decimal point setting of Nutrifact details. 
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3.8.1.18. Date Time 

- This menu is for configuration date time 

 

 

 

1) Set each item. 
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■ Decimal Point Separator 

- This is the setting for the format when printing the label time. 

 

3.8.1.19. Label 

- This menu is for configuration label 
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1) Set each item. 

 

■ Common Label Settings 

- This is the setting whether to set each Label field in batches. 

■ Label Change Mode 

- This is the setting whether to temporarily use the label and barcode form changed 

with the [Label1~Label 20] key.  

(Yes: Save the value after using the label call key / No: Do not save after using the 

[Label1~Label 20] key) 
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3.8.2. Admin – Language / Keyboard 

3.8.2.1. Display Language 

- This menu is for setting the language that is displayed on the scale screen. 

 

 

1) Choose the language, then press “Save” button. 
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2) You can see that the language has been changed. 
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3.8.2.2. Keyboard 

- This menu is for configuring the scale’s on-screen keyboard. 

 

 

3.8.2.2.1. Add Keyboard  

 - You can add on-screen keyboard. 

 1) Press “Add” button to show the list of on-screen keyboard. 
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2) Choose the on-screen keyboard from the list. 

 

 

 

3) You can set the font for the virtual keyboard. (Applies to all virtual keyboards.) 
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4) Press “Save” button. 

 

 

- You can check the configured keyboards (pressing Language Change key will change 

the keyboard to the next configured language). 
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3.8.2.2.2. Delete Keyboard     

- You can delete unused / disused on-screen keyboards. 

1) Click “Modify” button. 
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2) Click the trash can icon to delete an on-screen keyboard. 

 

3) Click “Save” button. 
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3.8.2.2.3. Modify Keyboard  

1) You can set the default keyboard layout when using multiple keyboard layouts. 

The keyboard language at the top of the list will be the default keyboard layout for the 

On-screen keyboard. Click an icon, drag & drop it to move keyboard of the selected 

language up or down on the list. 

 

 

2) You can set to other keyboard layouts by clicking their icon. 
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3) Click “Save” button. 

 

 

4)  You can see that the keyboard layout has been changed. 

If Russian keyboard is set to top, language of virtual keyboard will be set to Russian.  

(You can also use other keyboard layouts by pressing the language change key right next 

to the Space key) 
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3.8.2.3. Print Language 

- This menu is the CAS font print setting menu. 

 

 

1) After selecting the CAS font to use, click the Save button to save. 
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3.8.3. Admin – Initialization 

3.8.3.1. Mart 

- This is the menu to proceed with the initialization. 

 

 

1) Click the ‘Mart Initialization’ button 
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2) When the notification window pops up, click the “OK” button. 

 

 

3) Select the SALE MODE and the Mart to install and click the “Next” button 
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# ASSIST MODE – The way the clerk sells it. 

# SELF MODE – The way consumers buy it themselves. 

 

 

4) After setting the time, click the “Apply” button. 
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5) Press the “OK” button to initialize. When initialization is complete, it reboots. 

 

 

 

6) It is initialized to the selected mart. 
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4. TROUBLESHOOTING 
 

1. Communications Issue   
 

Symptom Troubleshoot 

Can’t access the LAN 

▪ Check the hub or the switch 

▪ Check the RJ45 network cable 

▪ Check the LAN LED 

▪ Reinstall the LAN card 

▪ Replace the mainboard 

 

2. USB Issues 
 

Symptom Troubleshoot 

USB port does not work 

▪ Check the status of plugged devices in the windows’ Device 

Manager 

▪ Check USB device status and connectivity 

▪ Remove and reinstall the USB driver 

▪ Change the USB device 

 

3. Display Issues 
 

Symptom Troubleshoot 

LED backlight does not work 

▪ Check the display cable 

▪ Check the inverter cable 

▪ Replace the inverter cable 

▪ Replace the display panel 
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4. Touchscreen Issues 
 

Symptom Troubleshoot 

Touchscreen does not sense 
tactile input 

▪ Check the BIOS configuration 

▪ Check the mainboard and the LCD cable 

▪ Recheck the BIOS configuration 

 

5. Power Issues 
 

Symptom Troubleshoot 

System does not load 
following a sudden 
shutdown 

▪ Check the A/C cable 

▪ Check the mainboard power 

▪ Check the CPU configuration/status 

▪ Check the system memory configuration 

▪ Check the power button cable 

▪ Replace the adapter device 

 

6. Booting Issues 
 

Symptom Troubleshoot 

Reboot during system 
operation 

▪ Check the SATA cable 

▪ Check the memory status 

 

7. Reading Issues 
 

Symptom Troubleshoot 

Weight reading does not 
appear 

▪ Check the RS232C cable 

▪ Check the installed folder 
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